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This program is free and may be freely distributed provided it is not 
sold or modified in any way. Requires Microsoft Windows™ 3.0 or later.

==========================================
===================
About this Manual

This manual is divided into the following sections:

1. Overview of the MasterCook PC Import/Export Utility -- This 
section tells you basic information about the purpose and functions of 
the Import/Export utility.

2. Installing the MasterCook PC Import/Export Utility -- Explains 
how to set up the import/export utility, create an icon for it, and run 
the utility.

3. Importing Recipes into MasterCook PC Cookbooks -- Explains 
how to import recipes from other software program text files (as well 
as MasterCook PC cookbooks saved as text files) into MasterCook PC 
cookbook files.

4. Copying Recipes from One MasterCook PC Cookbook to 
Another -- Explains how to copy recipes already in MasterCook PC 
cookbook file format to a different cookbook file.

5. Exporting Recipes from a MasterCook PC Cookbook -- Explains
how to convert recipes from a MasterCook PC cookbook file to an ASCII 
text file.

6. Formatting a Document as a MasterCook PC Export File -- 
Explains how to prepare a word processing or text document so that it 
can be imported as a MasterCook PC export document into a 
MasterCook PC cookbook file. This is especially useful for formatting 
documents created by scanning cookbooks. 

NOTE: It is your responsibility to ensure that any recipes you scan are 
from public domain cookbooks or from cookbooks whose copyright 
restrictions permit the copying of recipes into an electronic format. (If 
the cookbook you wish to scan forbids the copying of recipes, you can 
write to the publisher for permission to copy its recipes for your 



personal use only. Most publishers are very cooperative but please 
keep in mind that they must consider the intellectual property rights -- 
and business interests -- of both the publishing company and the 
book's author.)

7. Quitting the MasterCook PC Import/Export Utility -- Explains 
how to quit the utility.

Section headings appear in boldface and are underlined; sub-headings 
are italicized. Steps for performing tasks are numbered and in boldface
if the task requires more than one step for completion, or are preceded
by a "•" character and are boldface if there is only one step required 
by the task.

==========================================
===================
1. Overview of The MasterCook PC Import/Export Utility 
The MasterCook PC Import/Export Utility is designed to allow users of 
MasterCook PC to (1) convert recipes from different cooking software 
program into MasterCook PC cookbook files; (2) to copy recipes from 
one MasterCook PC cookbook file to another; and (3) to export 
MasterCook PC recipes to ASCII text files. 

When you export recipes from a MasterCook PC cookbook file to an 
ASCII text file, the text file is given the extension ".MXP" (for 
"MasterCook PC Export"); this file can be read by either a word 
processor, such as Word Perfect or Microsoft Word, or a text processor, 
such as the Windows Notepad. Recipes can be imported into an 
existing MasterCook PC cookbook file, or you can create a new 
cookbook file with the utility and then import recipes into it. You can 
import recipes into MasterCook PC that have the following formats:

• Meal-Master (extracted as text including version 7.x)
• Compu-Chef (exported as text)
• Micro Cookbook (extracted as text)
• MasterCook PC text file (.MXP file, created with this utility)

You can also copy files from one MasterCook PC cookbook file to 
another with this utility.

Whether you're importing or exporting, you can choose all the recipes 
in a file or just a limited selection (one or more) to be 
imported/exported.

The MasterCook PC Import/Export Utility features only one pull-down 
menu -- the File menu -- which contains three commands: Import or 
Copy to MasterCook PC, Export from MasterCook PC, and Exit.



==========================================
===================
2. Installing the MasterCook PC Import/Export Utility 
You've already performed the first step in installing the MasterCook PC 
Import/Export Utility: decompressing ("exploding") the file you 
downloaded, "MCMPXP.ZIP", with PKUNZIP. Three files were produced: 
this user manual file, titled "README.WRI"; the Import/Export Utility 
file, "MCIMPEXP.EXE"; and a text file, "MSTRCOOK.WRI", which provides
information about the MasterCook PC program and where to purchase 
it. To complete the set-up of the utility program, let's move the utility 
into the directory where you wish to keep it (for example, the 
MasterCook PC directory, /MSTRCOOK) and then give the utility its own 
icon in the same group as the MasterCook PC program.

To Move the Import/Export Utility and Create Its Icon:
1. Use File Manager to move the file "MCIMPEXP.EXE" to the 
desired directory.

2. Select the group window to which you wish to add the 
Import/Export utility icon.
You can select the group window by clicking its title bar or by 
choosing it from the Window menu in Program Manager.

3. Choose New from the File Menu.
The New Program Object dialog box appears.

4. Select Program Item and choose OK.
The Program Item Properties dialog box appears.

5. Type MCPC Import/Export in the Description text box.

6. Type in the Command Line text box the directory path 
you've assigned to the utility followed by MCMPXP.EXE.
For example, if you've installed the utility in the directory 
/MSTRCOOK, you would type C:/MSTRCOOK/MCMPXP.EXE.

7. Choose OK.
The MasterCook PC Import/Export icon appears in the designated 
group window.

To Start the Import/Export Utility:
• In Program Manager, double-click the MCPC Import-Export 
icon.
The MasterCook PC Import-Export splash screen appears. There is a 
single menu choice, File.



==========================================
===================
3. Importing Recipes into MasterCook PC Cookbooks
Before attempting to import recipes into a MasterCook PC cookbook, it 
must be in one of the following text file formats:

• A Compu-Chef file saved as a text file with the Compu-Chef Export 
command on the Utilities menu;

• A Meal-Master file saved as a text file with the Meal-Master Extract 
command on the Utilities menu;

• A MasterCook PC cookbook file saved as a text file (.MXP) with the 
Export from MasterCook PC command on the File menu of this 
utility program. (See the section below titled "5. Exporting Recipes 
from a MasterCook PC Cookbook".)

• A word processing or text processing document saved in the 
MasterCook PC export file format. (See the section below titled "6. 
Formatting a Document as a MasterCook PC Text File".)

To Import Recipes into a MasterCook PC Cookbook:
1. Choose Import or Copy to MasterCook PC from the File Menu.
The Choose Import File dialog box appears.

2. Select from the Files list box the file from which you wish 
to import recipes.
Scroll the list, if necessary, until the appropriate file comes into view 
and then click on the filename. When you click on the filename, its 
file type is displayed below, following the words "Cookbook Type". If 
you click on the name of a file that the Import/Export utility can't 
read, the word "Unknown..." appears following "Cookbook Type:" and 
you won't be allowed to open that file.

To look for a file on a different directory, choose the appropriate 
directory from the Directories list box.

To restrict the files displayed in the Files list box to a specific format, 
choose that format from the List File drop-down list. Only files of that 
type will appear in the Files list box.

3. Choose OK.
A message box appears, telling that the program is reading the recipe
titles. Then the Import or Copy Recipes to MasterCook PC dialog box 
appears.

4. Select the recipes you wish to import from the Recipes list
box.
Click the name of each recipe to be imported, OR use the Direction 
(Arrow) keys to highlight each recipe to be imported and then press 



Spacebar.

To select all the recipes in the file, choose Select All. To de-select all 
selected recipes, choose De-Select All. To change the selected recipes
to unselected recipes and vice versa, choose Invert Sel (for "invert 
selection").

5. Select from the Cookbooks list box the cookbook file to 
which you wish to import the recipes.
Click the name of the cookbook file in the Cookbooks list or use the 
Direction keys to move the highlight over the desired cookbook. The 
selected cookbook's name appears in the text box in the upper-right 
of the dialog box, following the label Cookbook.

To select a cookbook on another directory, choose the appropriate 
directory from the Directories list box and then choose the 
appropriate cookbook file.

To import the recipes to a new, empty cookbook file, choose New 
Cookbook. A dialog box will appear, asking you to name the new 
cookbook. (As with creating new cookbooks in MasterCook PC, you 
can give the cookbook any name you like; the cookbook will be saved
with a DOS filename consisting of the first eight characters of the 
cookbook name -- minus spaces -- and the file extension .MCF.) Type 
in a name for the cookbook and choose OK.

6. Choose the Import button to begin the import.
A dialog box appears, telling you the number of recipes you have 
selected to be imported and asking if you want to automatically 
replace recipes already in the cookbook file with new recipes from the
import file having the same name. If you choose Yes, the utility will 
automatically replace all recipes in the cookbook having the same 
name as a recipe in the import file without asking if you want to 
replace it. If you choose No, the utility will display a dialog box each 
time it encounters a duplicate recipe name, to allow you to choose 
whether or not to replace the recipe in the cookbook file with the new
import file recipe. If you choose Cancel, the Import operation is 
cancelled and you're returned to the Import or Copy Recipes to 
MasterCook PC dialog box.

If you don't choose Cancel, the name of each selected recipe is 
displayed as it's imported into the cookbook file. When all the 
selected recipes have been imported, a dialog box appears, telling 
you the number of recipes successfully imported and asking if you 
wish to remove the names of the imported recipes from the Recipes 
list (to help you avoid importing the same recipe twice). Choose Yes 



to remove the recipe names from the list; choose No to leave them 
displayed.

When the recipes are imported (or if you choose Cancel) you're 
returned to the Import or Copy Recipes to MasterCook PC dialog box. If 
you wish, you can select and import more recipes to the same 
cookbook, or change the name of the cookbook you wish to import 
recipes into. (This way you can import recipes from the same file to 
several different cookbooks without starting over.) When you wish to 
quit or choose another cookbook or text file to copy or import from, 
choose Cancel. You're returned to the Choose Import File dialog box, 
from which you can choose a new cookbook file to import recipes from,
choose a text file to import recipes from, or choose Cancel to quit to 
the splash screen.

==========================================
===================
4. Copying Recipes from One MasterCook PC Cookbook to 
Another
The procedures for copying recipes from one MasterCook PC cookbook 
file to another are almost identical to those for importing recipes from 
a text file into a MasterCook PC cookbook. The only difference 
perceptible to you as a user is that the Import button in the Import or 
Copy Recipes to MasterCook PC dialog box changes to the Copy button,
to reinforce the idea that you are not importing recipes in a foreign 
format into a cookbook file, but are instead copying recipes from one 
cookbook file to another.

To Copy Recipes from a MasterCook PC Cookbook to Another 
MasterCook PC Cookbook:

1. Choose Import or Copy to MasterCook PC from the File Menu.
The Choose Import File dialog box appears.

2. Select from the Files list box the file from which you wish 
to import recipes.
Scroll the list, if necessary, until the appropriate MasterCook PC 
cookbook file comes into view, and then click on the cookbook 
filename. (All MasterCook PC cookbook files have the file extension 
".MCF", so they're easy to identify.) When you click on the filename, 
its file type is displayed below, following the words "Cookbook Type:". 
The filename you select should say "MasterCook PC Cookbook"; if it 
doesn't you're not really copying from one cookbook file to another. 
(To restrict the files displayed in the Files list box to the MasterCook 
PC cookbook file format, choose "MasterCook PC Cookbooks (*.MCF)" 
from the List File drop-down list. Only cookbook files will then appear 



in the Files list box.)

To look for a cookbook file on a different directory, choose the 
appropriate directory from the Directories list box.

3. Choose OK.
A message box appears, telling that the program is reading the recipe
titles. Then the Import or Copy Recipes to MasterCook PC dialog box 
appears.

4. Select the recipes you wish to import from the Recipes list
box.
Click the name of each recipe to be imported, OR use the Direction 
(Arrow) keys to highlight each recipe to be imported and then press 
Spacebar.

To select all the recipes in the file, choose Select All. To de-select all 
selected recipes, choose De-Select All. To change the selected recipes
to unselected recipes and vice versa, choose Invert Sel (for "invert 
selection").

5. Select from the Cookbooks list box the cookbook file to 
which you wish to copy the recipes.
Click the name of the cookbook file in the Cookbooks list or use the 
Direction keys to move the highlight over the desired cookbook. The 
selected cookbook's name appears in the text box in the upper-right 
of the dialog box, following the label Cookbook.

To select a cookbook on another directory, choose the appropriate 
directory from the Directories list box and then choose the 
appropriate cookbook file.

To import the recipes to a new, empty cookbook file, choose New 
Cookbook. A dialog box will appear, asking you to name the new 
cookbook. (As with creating new cookbooks in MasterCook PC, you 
can give the cookbook any name you like; the cookbook will be saved
with a DOS filename consisting of the first eight characters of the 
cookbook name -- minus spaces -- and the file extension .MCF.) Type 
in a name for the cookbook and choose OK.

6. Choose the Copy button to begin the copy procedure.
A dialog box appears, telling you the number of recipes you have 
selected to be imported and asking if you want to automatically 
replace recipes already in the cookbook file with new recipes from the
import cookbook file having the same name. If you choose Yes, the 
utility will automatically replace all recipes in the cookbook having 



the same name as a recipe in the import cookbook file without asking
if you want to replace it. If you choose No, the utility will display a 
dialog box each time it encounters a duplicate recipe name, to allow 
you to choose whether or not to replace the recipe in the cookbook 
file with the new import cookbook file recipe. If you choose Cancel, 
the Copy operation is cancelled and you're returned to the Import or 
Copy Recipes to MasterCook PC dialog box.

If you don't choose Cancel, the name of each selected recipe is 
displayed as it's copied into the cookbook file. When all the selected 
recipes have been imported, a dialog box appears, telling you the 
number of recipes successfully copied and asking if you wish to 
remove the names of the copied recipes from the Recipes list (to help
you avoid importing the same recipe twice). Choose Yes to remove 
the recipe names from the list; choose No to leave them displayed.

When the recipes are copied (or if you choose Cancel), you're returned 
to the Import or Copy Recipes to MasterCook PC dialog box. If you wish,
you can select and copy more recipes to the same cookbook, or 
change the name of the cookbook you wish to copy recipes to. (This 
way you can copy recipes from the same cookbook to several different 
cookbooks without starting over.) When you wish to quit or choose 
another cookbook or text file to copy or import from, choose Cancel. 
You're returned to the Choose Import File dialog box, from which you 
can choose a new cookbook file to copy recipes from, choose a text file
to import recipes from, or choose Cancel to quit to the splash screen.

==========================================
===================
5. Exporting Recipes from a MasterCook PC Cookbook
When you export recipes from a MasterCook PC cookbook file, you 
create a new text file with the file extension ".MXP". This text file can 
be read by a word processor (such as Word Perfect or Microsoft Word) 
or text processor (Notepad); it can also be imported into a page layout 
program, such as Pagemaker.

To Export Recipes from a MasterCook PC Cookbook:
1. Choose Export from MasterCook PC from the File Menu.
The Choose Cookbook to Export dialog box appears.

2. Select from the Files list box the cookbook file from which 
you wish to export recipes.
Scroll the list, if necessary, until the appropriate MasterCook PC 
cookbook file comes into view, and then click the cookbook filename. 
The cookbook filename appears in the text box labelled Cookbook 
Name at the top of the dialog box.



To look for a cookbook file on a different directory, choose the 
appropriate directory from the Directories list box.

3. Choose OK.
The Export Recipes from MasterCook PC dialog box appears.

4. Select the recipes you wish to export from the Recipes list
box.
Click the name of each recipe to be imported, OR use the Direction 
(Arrow) keys to highlight each recipe to be imported and then press 
Spacebar.

To select all the recipes in the file, choose Select All. To de-select all 
selected recipes, choose De-Select All. To change the selected recipes
to unselected recipes and vice versa, choose Invert Sel (for "invert 
selection").

5. Select from the Files list box the MasterCook PC export 
file to which you wish to export the recipes.
Click the name of the MasterCook PC export file in the Files list or use 
the Direction keys to move the highlight over the desired export 
filename. The selected filename appears in the text box in the upper-
right of the dialog box, following the label Export Filename.

To select an export file on another directory, choose the appropriate 
directory from the Directories list box and then choose the 
appropriate cookbook file.

To import the recipes to a new, empty export file, choose New. The 
insertion point moves to the Export Filename dialog box and the 
contents of the box are highlighted, so that they will be immediately 
replaced by whatever you type. You can type any name you wish, but
spaces and other illegal DOS filename characters will be removed and
only the first eight (legal) characters will be used for the name of the 
file.

6. If you wish to break up the lines in the text fields Notes 
and Directions, select the check box at the bottom-left of the 
screen.
If you choose this check box option, the long text areas of Notes and 
Directions will be broken up into lines; otherwise they will be a single 
block of text and will form lines differently depending on how your 
margins are set in your word processor, the size and type of the font 
you are using, etc. A good rule of thumb is: If you'll be using a word 
processor on the export file, leave this option unchecked; if you'll be 



using a text processor, such as Notepad, on the export file, select this
text box.

7. Choose the Export button to begin the export procedure.
If you are exporting to an existing MasterCook PC export file, a dialog 
box will appear, telling you that an export file with the filename you 
specified exists and asking if you wish to append the recipes to the 
end of the existing export file. If you choose Yes, the recipes are 
appended to the end of the export file. If you choose No, the recipes 
will replace the current contents of the export file. If you choose 
Cancel, you're returned to the Export Recipes from MasterCook PC 
dialog box.

When the recipes are exported (or if you choose Cancel), you're 
returned to the Export Recipes from MasterCook PC dialog box. If you 
wish, you can select and export more recipes to the same export file, 
or choose a different export file, or create a new export file. (This way 
you can export recipes from the same cookbook to several different 
export files without starting over.) When you wish to quit or choose 
another cookbook to export recipes from, choose Cancel. You're 
returned to the Choose Cookbook to Export dialog box, from which you 
can choose a new cookbook file to copy recipes from, choose a text file
to import recipes from, or choose Cancel to quit to the splash screen.

==========================================
===================
6. Formatting a Document as a MasterCook PC Export File 
There may be times when you wish to import recipes from a word 
processing file into MasterCook PC: for example, maybe you have been
keeping your recipes in a word processing format, or you've scanned a 
cookbook into a text file. Before MasterCook PC can read your text file, 
you want to make sure that each recipe is properly formatted; then 
you'll want to use your word processor to save the file as an ASCII text 
file. The instructions below explain how to properly format a text file as
a MasterCook PC export file, so that it may be imported into 
MasterCook PC. 

NOTE: Formatting a text file as a MasterCook PC export file is actually 
fairly easy, but you want to make sure you follow the guidelines below 
carefully. If you have any questions how the file should be formatted, 
use your word or text processor to look at an existing MasterCook PC 
export file.

The format for the MasterCook PC export file is rather strict.  It is 
important to have all the key labels exactly the same as listed below, 
including the number of spaces and upper-/lowercase letters; otherwise



the format will not be recognized by the MasterCook PC Import/Export 
utility. For your convenience, in the formatting instructions below, 
spaces are indicated by "*" symbols: one "*" equals one space.

To Format a Text File as a MasterCook PC Export File:
1.  Each recipe must begin with a line that has the words 
"MasterCook" and "from" in it.

2.  The recipe title is the first non-blank line which is at least 
2 lines after line 1.

3.  The following labels mark the beginnings of respective 
fields -- note the numbers of spaces.
         1         2
12345678901234567890
"Recipe By*****:"
"Serving Size**:"
"Preparation Time:"
"Categories****:"

4.  Categories follow the label "Categories****:" and must be 
evenly spaced with the left being at least 31 spaces wide 
(from start of first category to start of second category.)

The categories can take up to 5 lines (10 categories total).

5.  The start of Recipe Ingredients is marked by the words 
"Amount," "Measure," and "Ingredient" on the same line and 
in that order.

6.  The dashes ("-" characters) on the next line tell the 
Import/Export program exactly at which column Amount, 
Measure, and Ingredient start and how many spaces the 
Amount and Measure fields take up. The Ingredient field 
begins with the third set of dashes and ends at the end of the
line.

7.  A list of Amounts, Measures, and Ingredients follows -- 
they must fall into the same columns as specified by line 6.  
Note that two dashes surrounded by spaces ("*--*") separate 
the Ingredient and Preparation Method columns.

8.  A blank line marks the start of Directions.

9.  Directions are in free text form and lines can be as long as
necessary.  However, if you wish to break up the lines, then 



leave a space at the end of any line that needs to be 
concatenated to the next line.

10. The end of the Directions area is marked by a sequence of
dash characters followed by spaces: 
"-*-*-*-*-*" (at least 5 dash/spaces).

11. Include the following labels and their respective fields:
         1         2
12345678901234567890
"Serving Ideas*:"
"Suggested Wine:"

12. The label for the field "NOTES*:" must be capitalized.  The
text is the same free-form text as for Directions -- see line 9.

13. Nutritional associations are codes that are used by 
MasterCook to reference internal ingredients.  They are 
preceded by the label "Nutr. Assoc.*:" and followed by codes 
for every ingredient.  These are not necessary and we 
recommend that you don't use them when creating a 
MasterCook PC export file.

14. Save the file as an ASCII text file with the extension 
".MXP".

==========================================
===================
7. Quitting the MasterCook PC Import/Export Utility     

• From the splash screen, choose Exit from the File menu.
The MasterCook PC Import/Export utility quits, returning you to 
Program Manager.


